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1 Qlik Salesforce Connector 

The Qlik Salesforce Connector provides a means for the QlikView business discovery platform to efficiently 

load data into a QlikView application from a Salesforce.com dataset. The metadata is used by the Create 

Select Statement dialog box to specify the table and columns to select for the SOQL SELECT statement. 

1.1 What’s new 

The following features and improvements are included in version 12 of the Salesforce Connector: 

 Ability to select deleted records: The Query All option on the SOAP API allows deleted records 

to be extracted during a data load. 

 Bulk extract for improved performance: The Bulk API can be used in place of the SOAP API to 

increase the speed of large data loads. 

 Alternate URLs: Alternative URLs can be used to specify different working environments within 

Salesforce.com, such as a sandbox environment.  

 Cross-object/Relationship queries: It is now possible to retrieve Salesforce.com data across 

related objects in a single SELECT statement. 

 Enhanced user-interface for connections: Converting SQL date-time values to SOQL, returning 

Boolean strings as text, and converting UTC to local time can now be done on the Salesforce 

Connection dialog rather than having to manually add parameters to the connection script. 

See Differences between version 11 to version 12 for changes you must make to version 11 

connections work with version 12 of the Salesforce Connector. 

2 Install the Qlik Salesforce  Connector 

1. Download the QvSalesforceConnector_setup.exe file from the Qlik download site. 

Note: Version 12 of the Qlik Salesforce Connector runs only on systems with 64-bit 

processors. 

2. Run the QvSalesforceConnector_setup.exe. 

The Qlik Salesforce Connector InstallShield Wizard sets up the installation environment and 

completes the installation.  

The Connector is then available from the QlikView Desktop with the name 

“QvSalesforceConnector.exe.” 

3. Open the QlikView11 Desktop application. 

If QlikView is open when you install the Salesforce Connector, you must close and reopen it in 

order for QlikView to recognize the Connector. 
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3 Differences between version 11 to version 12 

 The value for the Provider parameter in the CUSTOM CONNECT TO string in the connection 

script is “QvSalesforceConnector.exe” in version 12.  To reuse a version 11 connection script, you 

must replace the Provider parameter value with “QvSalesforceConnector.exe”. 

 The ability to select deleted records is now available with the Query All option for SOAP mode 

(see Select the Bulk or SOAP API to use with the connection.). Query All replaces the SELECT_ALL 

statement, which is not supported in load scripts for version 12. To select only deleted records, 

you can still use the use “isDeleted=true” in the WHERE clause of the query, but it is used with 

the SELECT statement rather than the SELECT_ALL statement. For example, if SOAP mode Query 

All is selected, the following syntax is valid: 

SELECT BillingCity, BillingCountry FROM Account WHERE isDeleted=true 

 The LocalTime parameter used to set the way the Salesforce Connector returns date-time values 

can now be controlled by the Convert UTC to local time check box in the Salesforce Connection 

dialog. Using the state of Convert UTC to local time, the Connector inserts the parameter 

named ConvertToLocalTime in the CUSTOM CONNECT TO statement, and the parameter value 

is set to either “true” or “false”. If you change the setting manually after the CUSTOM CONNECT 

TO statement has been generated by the Connector, you must use either “true” or “false”. In 

version 11, the parameter value can be “yes,” “on,” or “1” as well as “true,” or “no,” “off,” or “0” as 

well as false, but in version 12, only “true” or “false” can be used as the parameter value. For 

example, ConvertToLocalTime=true. 

 As with the ConvertToLocalTime parameter, the BooleanAsString parameter only accepts 

“true” or “false” as its values in the CUSTOM CONNECT TO statement. The Boolean as String 

check box in the Salesforce Connection dialog enables you to select whether Boolean values are 

displayed as “0” and “1” or “true” and “false.” If you manually change the setting after the 

CUSTOM CONNECT TO statement has been generated by the Connector, you must use either 

“true” or “false”. In version 11, the parameter value can be “0” or “true” and “1” or “false,” but in 

version 12, only “true” or “false” can be used as the parameter value. 
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4 Create a Salesforce connection  

Access to the Qlik Salesforce Connector is provided by the QlikView business discovery platform. QlikView 

applications connect to data sources through the Script Editor. 

1. Open a new or existing QlikView application. 

2. Click Edit Script... on the File menu in the main QlikView window. 

3. Select QvSalesforceConnector.exe from the drop-down list next to Connect... on the Data tab in 

the lower part of the Edit Script dialog. 
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4. Click Connect... to open the Salesforce Connection dialog. 

 

5. Enter the user name and password for the Salesforce account. 

6. Enter the security token assigned to the account. 

7. Enter the URL for an alternative Salesforce.com area you want to connect to. 

By default, the Salesforce Connector connects to your account’s “production” area. Every account 

also has a sandbox area to work in before committing to the production area. The sandbox area 

URL can be entered, optionally, in the URL text box to direct the Salesforce Connector to open 

that area instead of the default “production” area. 

8. Click Test Connection to verify that a connection can be made with the account properties 

entered. 

9. Select the Bulk or SOAP API to use with the connection. 

Note: When choosing between SOAP and Bulk APIs, you must know whether or not you need 

to load multiple Salesforce objects with a relationship query (see Load multiple Salesforce 

objects below). The SOAP API is required when loading data with relationship queries. 

Note: The Bulk API does not support aggregation functions, grouping, or field aliases. 

Note: If you use Bulk API, the Salesforce Bulk API must be enabled for the account that is 

reading the data on Salesforce.com. 

10. Click Query or Query All on the SOAP mode menu. 

If you use the SOAP API to connect to Salesforce, you can read all records in the Salesforce object 

that have not been marked as deleted (Query). Or you can read all records in the Salesforce 

object including those that have been marked as deleted (Query All). 
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11. Specify the batch size, which is the maximum number of rows written to the data target in one 

batch. 

The batch size can be used to control the speed at which QlikView and Salesforce.com 

communicates. If a batch size is not specified or Salesforce.com does not accept the set batch 

size, the Connector tries to use the maximum allowed batch size of 2000 and then increments 

down in steps using the following predefined batch sizes: 

2000, 1000, 500, 200, 100, 50, 20, 10, 5, 2, 1 

12. Select Convert SQL dates to convert dates entered in the format YYYY-MM-DD hh:mm:ss to the 

SOQL format. 

SQL date-time data type is often used in WHERE clauses, but that data type format does not 

match date-times in a Salesforce object. If the Convert SQL dates box is selected, date-time 

values entered in the YYYY-MM-DD hh:mm:ss format are automatically converted to the SOQL 

format used for the date-time data type. 

If Convert SQL dates is not selected, date-time values submitted to Salesforce.com in SQL 

format would not match any date-time values in the Salesforce.com object database. See the 

discussion of the WHERE clause in the section below on creating a load statement. 

13. Select Boolean as String to return Boolean values as “true” or “false” strings.  

If Boolean as String is not selected, Boolean values are returned as “0” or “1.” 

14. Select Convert UTC to local time to convert date-time values returned by the Connector to the 

local time of the computer the Connector is running on. 

If Convert UTC to local time is not selected, the Connector returns date-time values from 

Salesforce.com in Coordinated Universal Time (UTC). 

15. Click OK to create the connection string used when sending the load statement to 

Salesforce.com. 

16. Change the default proxy setting if necessary. 

After the connection string has been generated and placed in the script panel in the Edit Script 

dialog, the proxy setting can be changed by adding the Proxy and ProxyBypass parameters 

manually, if necessary. 

By default, the Salesforce Connector uses the proxy settings defined in the Windows Proxy 

settings, which can be accessed in Internet Options in the Control Panel. The Proxy and 

ProxyBypass parameters must be set as described in the Microsoft article “Enabling Internet 

Functionality”. The parameter syntax is: 

<parameter name>=<value>[;] 

The semicolon (;) is used to separate parameters in the connection string.  

As examples, the parameter syntax can be formatted like any of the following: 

Proxy=10.10.10.10:880;ProxyBypass=<local> 

Proxy=http://www.site.com:8080;ProxyBypass=<local> 

The proxy server’s port must be included. To list a proxy for a specific protocol, such as http, the 

protocol string must be used explicitly, as in the example above.  

The parameters can be placed at any location in the CUSTOM CONNECT TO string. When 

multiple proxy hosts are listed, they must be separated by a vertical bar, not semicolons as 

indicated in the “Enabling Internet Functionality.” The Salesforce Connector uses semicolons to 

separate parameters. In the following example, the two proxies are separated by a vertical bar 

and the Proxy and ProxyBypass parameters are separated by a semicolon: 

Proxy=http://www.site.com:8080|http://www.site2.com:8080;ProxyBy

pass=<local> 

http://msdn.microsoft.com/en-us/library/windows/desktop/aa383996%28v=vs.85%29.aspx
http://msdn.microsoft.com/en-us/library/windows/desktop/aa383996%28v=vs.85%29.aspx
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5 Create a load statement 

1. Click the enabled Select... on the Data tab in the lower part of the Edit Script dialog. 

The Edit Script dialog has two Select… buttons when the Salesforce Connector has been 

connected but only the bottom button is enabled.  

2. Select a database table from the list in the Create Select Statement dialog. 

 

3. Select the fields to load from the Fields list. 

Press the Control (Ctrl) key to select multiple fields.  

The SOQL SELECT statement that will be used to load data from the Salesforce.com database 

displays under the SOQL Query text box in the bottom portion of the dialog. 

The “SELECT *” statement can be added manually in the SOQL Query text box to select all fields 

in the table. The SOQL query language does not support the “SELECT *” statement, but the 

Salesforce Connector has been enhanced to recognize that syntax. Only asterisks (*) and simple 

field names can be used in the SELECT statement. Qualified field names, such as 

“Contact.FirstName,” are not permitted. The “SELECT *” statement can only be used when Bulk  is 

selected. 

It is permissible to prefix the table name with the string “Salesforce.” Table and field names can 

also be put in brackets. For example, the following SELECT statement is valid: 

SELECT [FirstName] FROM Salesforce.[Contact]; 

4. Click Validate to verify that the SELECT statement query is valid. 

If you click OK before Validate, the statement is validated before it is added to the load script. 

5. Click OK when you are finished making your selections. 

The SOQL SELECT statement does not include a WHERE clause, but one can be added in the Load 

Script editor. The SOQL SELECT statement for the Salesforce Connector supports the addition of 

WHERE clauses. If the selected field uses a date or date-time data type, the date-time format 

YYYY-MM-DD hh:mm:ss is automatically converted to the SOQL date-time (YYYY-MM-

DDThh:mm:ssZ) if Convert SQL dates  is selected in the connection dialog. SOQL uses "Z" on the 

time to indicate that the time is to be read as absolute, with no time zone offset. In SOQL, “Z” can 

be substituted with an offset value. For example, the date “2009-02-24 23:01:01” in Eastern US 

time zone would be “2009-02-24T23:01:01-05:00” in SOQL. Because the YYYY-MM-DD hh:mm:ss 

format has no offset value, the date-time is converted to Coordinated Universal Time (UTC).  

Note: The Convert UTC to local time setting does not affect the time zone in date-time 

values sent to Salesforce.com in WHERE clauses. The Convert UTC to local time setting 
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handles the display of date-time values returned from Salesforce.com, not the values sent 

to Salesforce.com. 

The SOQL SELECT statement for the Salesforce Connector also supports: 

 Added field types: The Salesforce Connector recognizes “anyType,” “time,” 

“encryptedstring,” “masterrecord,” and “DataCategoryGroupReference.” The data type 

“time” denotes a time of day, as distinguished from the “datetime” type, which holds 

both a date and a time of day. 

 String escape characters: The Salesforce Connector uses the single quotation mark 

character as an escape character instead of the back slash (\) used by SOQL. To include 

a single quotation mark in a query string, it must be prefaced by another single 

quotation mark. For example, the following string encloses “Captain Awesome” in single 

quotation marks. 

Devon ‘’Captain Awesome’’ Woodcomb 

6 Load multiple Salesforce objects 

SOQL SELECT statements can be written to load multiple Salesforce objects. Such statements (relationship 

queries) must be entered directly in the SOQL Query text box. They cannot be created by selecting 

multiple objects and fields from the Objects and Fields lists. Each time you select an object from the list, 

that selection replaces any existing SELECT statement in the SOQL Query text box. To include multiple 

objects in the query, you must add them manually.  

In the following example, the SOQL SELECT statement includes fields from multiple objects. 

 

From this SOQL Query statement, the Connector creates separate load statements for each of the related 

tables. 



 

10 
 

 

 

The resulting load produces three related tables. 

 

 

7 Log information 

The Salesforce Connector’s log file is located at:  

{ProgramData}\QlikTech\Custom Data\QvSalesforceConnector\Log 

Where {ProgramData} is %ALLUSERSPROFILE%. 

 

 

 


